
Audio Workshop Tutorial

Thanks for using Audio Workshop by DAK!

For a quickstart overview of using Audio Workshop’s primary functions, please review the individual slideshows from the ‘Help’ menu of Audio 
Workshop’s main interface. 
 
Select which section of Audio Workshop you’d like to explore:

  
I. Getting Started
	 1. Customizing Audio Workshop’s Appearance
		  a. Skin Color Configuration 
		  b. Waveform Configuration 

1. Recording
	 i. Before You record
	 ii. Adjusting Volume for a Recording Device
	 iii. If You Can’t Hear Your Music Through Your Computer
           1. Record Button Behavior
	 2. The Recording Process
	 3. Playing Back Your Recording
	 4. Minor Editing Capabilities
	 5. Using Zoom Effectively
	 6. Saving Your Work

2. File Editing
	 1. Loading Your File
	 2. The Edit Menu: A Closer Look
	 3. The Effects Menu 
		  a. Apply flat amplification 	 b. Apply sliding amplification 	 c. Apply amplification 	 d. Apply WavesReverb DirectX effect 	
		  e. Apply Equalizer 		  f. Custom DSPs 			   g. VST 				   h. Change Tempo 	
		  i. Change Playback rate 	 j. Change Pitch 			   k. Reverse Sound 		  l. Filters 
		  m. Normalize 			  n. DC Offset removal 			  o. Noise removal		  p. Vocal removal
	 4. Saving Your Work
	 5. Playback Controls
	

3. Track Splitting
	 1. Loading Your File
	 2. Silence Threshold Settings
	 3. AutoSplitting: Analyze Tracks by Silence
	 4. The Markers List
		  a. Manually Add a Track Marker
		  b. Delete a Track Marker
	 5. Exporting Your Tracks
		  a. Tagging MP3, WMA, FLAC, OGG Files

Remember- if you ever get stuck, if you see something here that isn’t clear or if you just want to leave us a comment, drop us a message! cs@dak.com

																				                        -Sol Harari	  
																				                              DAK.com
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I. Getting Started:

Let’s begin by familiarizing ourselves with the names for Audio Workshop’s various parts. The 
name of any given part is bolded the first time the term appears. 

Upon opening Audio Workshop, you’ll notice that there are program tabs at the top horizontal-
ly arranged and labeled Recording, File Editing, Track Splitting and About.

On the left hand side, you’ll see a vertically arranged menu list. If you click through the tabs, 
you’ll notice the menu list change slightly. The vertical menu list is particular to the tab you are 
currently using. That’s to say- each of these tabs has its own set of tools.

This main screen (the black area with the grid- although the color can be customized) is the 
waveform analyzer. It’s in this window that you get to see what is happening to your audio file 
displayed as a green waveform (color also customizable). The waveform will display after audio 
is either recorded or loaded into Audio Workshop.

The top half of the analyzer displays the left channel audio and the bottom half displays the 
right channel audio. The size of the waves indicates its volume, which you can measure against 
the amplitude ruler on the right hand side.

On the bottom you have a time ruler, which will display the timing of your audio at graded 
intervals. Beneath that is the vu meter, another visual aid to ensure both channels are recording 
properly and their volume. On the top is a scrollbar. The scrollbar can be resized to zoom into 
the waveform and then dragged from side to side to scroll across the waveform.

Finally, there is the Status bar, which will display Audio Workshop’s current action.   
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1. Customizing Audio Workshop’s Appearance
	 a. Skin Color Configuration

The skin color is simply the background color of Audio Work-
shop. Just select a basic color, or create your own, hit OK and you 
will see the skin color change.

b. Waveform Configuration

Here you can change the colors for the different elements in Audio 
Workshop, toggle how graphics are rendered and even toggle if some 
elements should be displayed at all.

These changes apply to all tabs of the program and do not revert back to 
default.   
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1. Recording:
1.i Before You Record- Setting up the Windows Mixer 

If you’ve never checked out the Windows Mixer (otherwise called Win-
dows Sound Control), it can be compared to a control box for your com-
puter’s soundcard. It’s where you decide which devices are primary over 
other available devices, or you can control individual volume levels.

Before we’re ready to record, we need to make sure the Windows Sound 
Control is set properly to recognize our audio inputs devices.

Audio Workshop conveniently has a shortcut to get to the Windows 
Sound Control. Just click on the Settings menu, and select Windows 
Sound Control.

The Windows Sound Control will pop up. Click on the Recording tab, 
since those are the devices we want to check.

	 *If you’ve correctly plugged in your line level device (like 		
DAK’s preamp mixer) into your computer’s blue colored 		  jack, 
and do not see “Line In” as your default device as pic		 tured to the 
right, right click and make sure your are 
	 showing all of your disabled and disconnected devices, then 	
	 find the appropriate recording device, enable it, and Set 		
Default.

	 *If you’re using a laptop with our Audio to USB adapter, the 		
recording device you need to set as default is not line in, but 		
usually named along the lines of “Microphone Array” with a 		
description indicating that it is a “USB CODEC”.

When viewing your available recording devices in the Windows Sound 
Control, double click on the appropriate device (for me, ‘Line In’). A 
second window with tabs will pop up displaying the properties of your 
selected device. 

See the image to the immediate right for reference.

Click on the ‘Levels’ tab. Adjust the volume as you see fit. 
I generally keep my volume at about 75%. Anything more than that 
might lead to too much amplification = slight distortion.

(If you’re using the DAK 2800 preamp mixer- you can always fine tune 
recording volume directly from the unit).

1.ii Adjusting the Volume for a Recording Device

1.iii If You Can’t Hear Your Music Through Your Computer 

Another option that is toggled through viewing the device properties 
is under the ‘Listen’ tab. 

There is a checkbox that governs whether or not you can hear audio 
through your computer as you play it and/or record it.

See the image to the right for reference.

Contents



Contents

1.1 Record Button Behavior

In the Settings menu, you’ll find a submenu called ‘Record Button 
Behavior’.  

This setting governs what happens whenever you click on the ‘Record’ button. You 
have one of four choices:

	 Create New Session: This is the default setting, and is probably 		
	 exactly what you might expect to happen when you press ‘Record’.  A new 	
	 session is created. That means that whatever is in the waveform analyzer is 	
	 erased and the new recording will take its place.

	 Append New Session to Existing Session: Your new recording will be   	
	 added to the end of whatever audio you currently have sitting in the wave	
	 form analyzer.

	 Insert New Session at Selected Position: Say you wanted to create an audio 	
	 track with an interruption. You would choose this setting. Click on the 	
	 spot in the waveform where you want to place the interruption, click 
	 ‘Record’ and your recording will be inserted right at the position of the 	
	 waveform you clicked. That position will be marked by a dotted yellow 	
	 line. Conceptually, this is the equivalent with a TV show being interrupted 	
	 by a special announcement.

	 Mix New Session at Selected Position: Same as ‘Insert’ except instead of 	
	 an interruption, the new recording would be mixed in to the original re	
	 cording at your selected poisition (the spot where you clicked on the wave	
	 form). It would be equivalent to an announcer talking over playing music.

1.2 The Recording Process

After you’ve set up your hardware and/or the Windows Sound Control properly, 
you’re ready to begin recording. Just click on the ‘Record’ button and you’ll be on 
your way.

As you’re recording, you should notice a few things:

	 The waveform analyzer is completely black, and is displaying a single 	
	 waveform (don’t worry, it’s still recording in stereo-- it’s just 	 a 
display 		  graphic showing both channels mixed).

	 The VU meter is reacting to the audio. You sohuld be seeing both 
	 channels reflected in the meter. If you DON’T see upper and lower set 	
	 of lights, one of your channels isn’t recording properly. You’ll need to 	
	 recheck your hardware setup.

	 The Status has changed from ‘Idle’ to ‘Recording’.

The ‘Pause’ button can be used to pause the recording then pick up where you left 
off. It keeps everything in the same recording session. 

The ‘Stop’ button (the red one, on the side of the recording controls) stops record-
ing and finalizes your recording session.

*Note: Even after your recording is finalized, and you see the correct waveforms, 
it is not yet saved! Don’t erase this session until you save your work. See section 
1.6 for more information.



1.3 Playing Back Your Recording

When you have completed the recording process, it is a good idea to spotcheck 
your recording to ensure the audio recorded properly. I usually click on any posi-
tion in the waveform at random and then press ‘Play’.

As audio plays back, you will see a solid yellow line (unless you customized its 
appearance) move across the screen. This is called the Playback Position line. 
During playback, clicking on the waveform will not do anything. You must click 
on either ‘Pause’ or ‘Stop’

The ‘Pause’ button will pause playback and keep the Playback Position line in 
place. When you press ‘Resume’, it resumes playback as expected.

The ‘Stop’ button will stop playback and totally reset playback. Pressing ‘Play’ 
after ‘Stop’ will playback your recording from the very beginning.

1.4 Minor Editing Capabilities

The Recording tab’s ‘Edit’ menu enables you to perform minor edits to your 
recording. There is the standard Cut Copy and Paste. 

Additionally, you can ‘Delete selection’. This is useful if you began the recording 
process and it took you an extra minute to press play on your turntable, so you 
have some dead space in the beginning of your recording. Just click and drag 
your mouse over the waveform whre the dead space is to select and highlight it 
and then delete it (the shortcut is to press Delete on your keyboard).

‘Reduce to selection’ is the exact opposite of ‘Delete selection’. Highlight an area 
on the waveform and Reduce to selection will delete everything EXCEPT for 
whatever is highlighted.

1.5 Using Zoom Effectively

When editing your files, you’ll want to be as precise as possible. Learning how to 
zoom in on an area that needs to be edited at exactly the right spot will come in 
handy sooner or later.

You can drag the ends of the green scrollbar on top of the waveform analyzer 
(by the little white squares). This resizes the scroll bar and zooms in on an area 
between the ends of the scroll bar. To be frank, I don’t love this method of zoom-
ing. 
I won’t even bother pasting the screenshot of the green scrollbar.

Actually, even going to the ‘Zoom Options’ menu and clicking Zoom in or Zoom 
out is only mildy useful.

When I have a specific area that needs editing, and I need to see it close up, I 
highlight the area I need, click on ‘Zoom Options’ and choose ‘Zoom to Selec-
tion’. It’s the easiest way to get a clear shot of the area you need to see. And you 
can repeat the process to hone in even more.

To zoom back out, choose either ‘Zoom out’ or ‘Zoom to full waveform’.

Highlighted selection

Zoom to selection
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1.6 Saving Your Work

When you’re satisfied with your recording, it is time to save your work before 
going on to the next program tab.

Click on ‘File’, then ‘Save As’.

A dialog box will appear in which you’ll determine the folder and file name 
for your recording. Choose a name and location that is easily identifiable and 
quickly accessible. I like to utilize my Desktop by creating a new folder to con-
tain my recordings. 
	 (You can create a folder directly from the Save dialog box by right click	
	 ing in the white space, selecting ‘New’ and clicking on ‘Folder’- see 		
	 image to the right.) 

Besides for the file name and destination, you will select the file type. The 
most popular file types are MP3 and WAV. MP3 are more compressed than 
WAV files and so take up less memory to store. Many audiophiles will claim 
that WAV files preserve audio quality better than MP3. There is truth to that, 
although it may not really be a perceptible difference.

After you click Save, a second dialog box will pop up, giving you further op-
tions for the file you are saving. Higher bit rates mean higher quality audio files 
along with more memory used up to store those files.

After your file is saved, you’re ready to move on to the next program tab.

2. File Editing:
2.1 Loading  Your File

Audio Workshop’s separate program tabs are, indeed, separate. That is to say 
that the work you do under ‘Recording’ does not carry over to ‘File Editing’ or 
‘Track Splitting’. That’s why there is the possibility to multi-task (although that 
is discouraged by our programmers... it would use a lot of RAM).

With that said, it’s necessary to begin your File Editing session by loading a file 
into Audio Workshop.

Click on ‘File’ then on ‘Open’. Locate the file you wish to edit and open it. 
Loading time will vary based on file size and computer processing speeds 
(shouldn’t take more than a few seconds).

Let’s begin editing.

2.2 The Edit Menu

*Tip- On the right hand side of the menu, you’ll see keyboard shortcuts for 
some of the editing functions.

Cut: Cuts out the selected (highlighted) portion of audio and retains it in the 	
        computer’s short term memory.
Copy: Copies the selected portion of audio, leaving the original intact.
Paste: Inserts the audio last Cut or Copied into a selected point.
Select all: Highlights the entire audio track.
Paste in ‘Insert’ mode’: The same as standard ‘Paste’, it’s just spelled out here 
			     to avoid mistakes.
Paste in ‘Mix mode’: Instead of inserting copied audio into a selected position, 
this overlays the copied audio on top of any audio already at that poisition.
(Continued)

Contents



Delete selection: Deletes the highlighted section of audio.
Reduce to selection: Deletes everything EXCEPT for highlighted section of 	
		           audio.
Insert silence: Choose the length of silence in milliseconds. 1000 
	             milliseconds is 1 second. Silence is inserted at selected position. 	
	             If nothing is highlighted, silence is inserted at the beginning of 	
	             the file.
Remove silence: If nothing is highlighted, all silences will be removed from 	
		  the audio file. If a section is highlighted, only that section will 	
		  have silences removed. Before you actually remove the silence, 	
		  you’ll need to tell the program how to determine a ‘silence’. See 	
		  the image on the right. 

		  Silence threshold reflects the amplitude. Silence threshold of 	
		  1000 means that any spot of the waveform where the volume 	
		  level drops below 1000 will be identified as a silence.

		  Of course, some songs have momentary pauses that you don’t 	
		  want identified as a silence. For that, you input the silence min-	
		  imal length. The silence must be at least x milliseconds long to 	
		  be considered for removal. The default value is half a second. 	
		  Adjust that as needed. 

		  We will see these parameters come up again in the Track Split-	
		  ting section of Audio Workshop.

Apply background sound: Mixes in an audio file of your choice that can loop 	
			         over and over until the end of the track.
Append sound file: Adds an audio file where the current audio track ends.
Insert sound file: Inserts an audio file at current selected position.
Mix sound file: Mixes an audio file at current selected position. If a selection 	
	 is highlighted, mixed in file will only be as long as the highlighted 		
	 selection. Example- if you highlight a 20 second portion of audio and 	
	 attempt to mix in a 30 second audio clip, only the first 20 seconds will 	
	 be mixed into the highlighted portion.

Undo: Undoes your previous action. This is particularly useful if you are 		
	 experimenting and don’t like a change you made. But be careful- you 	
	 can only undo the last action performed. 

2.3 The Effects Menu

a. Apply flat amplification: Increase or decrease the volume (amplification) of 	
	 your audio file by a percentage amount. If you have a section of your 	
	 file highlighted, amplification will only occur in higlighted selection.
b. Apply sliding amplification: Applies a fading effect to your entire audio 		
	 track, or to just your highlighted selection.  It is a percentage 		
	 amount. So if you input a percentage of 150, the beginning of the fade 	
	 will be 150 percent of the original amplification and the end will be 75 	
	 percent of the original amplification.
c. Apply amplification: This effect can be used to either increase or reduce the 	
	 dynamics of your file. Based on percentage points, louder points and 	
	 softer points are differentiated and so you can choose how much vol-	
	 ume to apply to each section.
d. Apply WavesReverb DirectX effect: The default values for this effect apply 	
 	 a slight reverb. I don’t completely understand how it works yet. 		
	 Be warned- if experimenting with this, make sure you save your work 	
	 from before. 
e. Apply Equalizer: Equalize as you wish, or use one of the presets. 
	 Equalization can also be applied to a highlighted section of your file.
f. Custom DSPs: (Currently unavailable)
g. VST: An acronym for Virtual Studio Technology. A quick google search for “free 	
	 vst equalizer plugins” will enable you to find a bunch of different effects (in 	
	 this search, equalizing programs). a VST is just a .dll file that can be loaded 	
	 into a host program. Download a .dll file (make sure the website seems legit-	
	 imate, and use an antivirus scanner), and load it into Audio Workshop. 
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h. Change Tempo: Adjust the playback speed of the file without the pitch.
i. Change Playback rate: Adjust both playback speed and pitch. 
	 **This is what you would use to convert a 45 rpm recording into a 		
	 78 rpm. If you don’t have a turntable that plays 78 rpm, just record the 	
	 78 as if it were a 45. Once it’s recorded, use ‘Change Playback rate’ 
	 to decrease  the playback rate by 1.15, click OK. 
	 Then increase the playback rate by 2. 
	 This will give you a 78.26086956521739 rpm. 
	 The exact standard should be 78.26, but the difference is negligible.
j. Change pitch: Adjust pitch but not playback speed.
k. Reverse: Reverses the sound.
l. Filters: Blocks a set range of frequencies from the audio file.
	 Low pass allows low frequencies and filters anything higher that the 	
	 set cutoff frequency.
	 High pass is the opposite, filtering (attentuating) frequencies below the 	
	 frequency cutoff.
	 Band pass only allows frequencies thayt are within a set range (Freq. 1 	
	 and Freq. 2 values need to be set.)
	 Stop band is the opposite, attenuating only frequencies that are within 	
	 the set range.	
m. Normalize: Normalize the volume across your audio file. Helpful if the file 	
	 was recorded over different volume levels and needs correcting. 
n. DC Offset removal: If the waveform of your recording does not appear 		
	 centered over the amplitude line of ‘0’, then your recording has a DC 	
	 offset (or DC bias). To correct this, use the removal tool to recenter it.
o. Noise removal: 
	 Pop and Click Removal: This tool is used to remove the pops and 		
	 crackling from LP recordings. The sensitivity parameter can take a 		
	 value from 0-100, the default value being 99. Higher sensitivity yields 	
	 better results but longer processing times.

	 Group sensitivity will attempt to group clicks together. The benefit 		
	 of this is that there are less filters involved when taking out multiple
	 clicks in one fell swoop. However, if the clicks are too sparse, an 
	 attempt to group them together may result in a a large swath of of 
	 valuable audio being swapped with interpolated audio. I usually keep 
	 it disabled at the default 0, but dpending on your audio file, it can be 
	 useful at preserving a higher degree of audio integrity. 

	 I keep the recover pitch checkbox checked. The original pitch usually 	
	 isn’t lost (nor have I ever seen it happen), but in case it is, it will try to 	
	 restore it automatically.

	 Remove Hiss: This tool is used to reduce hiss present in tape cassettes.
	 Window type allows you to select between different window 
	 functions that will break down the audio into pieces. The mathematics 
	 behind it is involved, and I just stick to the default window. They are 
	 all variations of a bell-shaped window.

	 Window size determines how many pieces the audio will be broken 
	 into. Higher values mean more pieces of audio get individual attention 	
	 (yielding better results and longer processing time).

	 A noise gain of 0 db will not remove any noise, while lower values will 	
	 remove noise more unilaterally. -40 is a good place to start. If you want 
	 to try removing more noise, undo your previous action then try going 
	 to -42, -44 and so on until you find the optimal setting for your audio 	
	 track. 

	 Attack/Decay time determines how much previous input history the 	
	 filter will use. Each time you use it, it will save this amount of seconds 	
	 of input audio to determine precise noise thresholds. higher values 		
	 mean more processing time.
	
	 Depending upon input audio characteristics, you may hear a constant 	
	 low frequency in output. Frequency smoothing takes care of that, and 	
	 may need to be fine tuned based on your results (usually not the case).
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p. Vocal removal: This is a fun tool and can be useful, but it is far from perfect. 	
	 Don’t expect it to completely remove vocals from the track. 
	 In theory, it works like this-
	 for stereo tracks, the vocals are usually the only part of the audio that 	
	 is dead-center. So if you subtract the left channel from the right chan	
	 nel, you’ll be left with a vocal track.  That vocal track gets subtracted 	
	 from both the left and right channels, which leaves you with just an 	
	 instrumental.
	 In reality, it isn’t that efficient. Reverb in the vocal track, instruments 	
	 overlapping in both channels and other variables make true vocal 		
	 removal impossible. The best you can hope for is a reduction of 		
	 the lead vocal track.

	 MP3 files don’t work nearly as well as WAV files due to the way MP3s
	 are encoded.

	 The gain parameter affects the output amplification (the resulting 
	 audio volume).
	 The cutoff frequency determines the low pass filter. Anything below 	
	 the cutoff will not be removed.
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2.4 Saving Your Work

Before moving on to the next step, always save your work. The steps are the 
same as outlined above in section 1.6. 

The main decision that you need to make is if you want to replace your origi-
nal recording with this newly edited file, or if you want to save it with a slight-
ly different file name. 

I like to keep both copies side by side for a while before delete the original 
recording. So I would save this edited file with an easily identifiable name 
similar to the original, only with EDITED added to the file name.

2.5 Playback Controls

These controls are mostly self explanatory. 
In order from left to right-
	 -Jump to beginning of track when stopped.
	
	 -Play from selected position (or beginning of track if no position 
	 selected).

	 -Loop play will play a highlighted selection over and over in a loop.

	 -Pause retains the current playback position.

	 -Stop resets the playback position.

	 -Jump to the end of track when stopped.

You use the mini scrolling waveform to fast forward or rewind. Just click and 
hold on the mini waveform and drag it from side to side.



3. Track Splitting:

As outlined above in section 2.1, your newly edited audio file must now be 
loaded into the Track Splitting tab. 

Click ‘File’ then ‘Open’ (this process should be familiar to you by now).

Locate your EDITED file- not the original recording- and open it.

Once that’s loaded up, you’re ready to split your tracks. You can split either 
autoatically or manually. We’ll cover auto-splitting first.

3.1 Loading  Your File

3.2 Silence Threshold Settings

Though you can skip ahead to 3.3, understanding the parameters found in 
‘Silence Threshold Settings’ will enable you to use the automatic 
splitting feature much more effectively. The program splits your audio file 
into individual tracks by analyzing silences between the tracks, so by 
configuring these settings based upon your audio file’s characteristics you 
get more precise results.

You’ll find Silence Threshold Settings under the ‘Settings’ menu.

There are only two parameters that are configured.

The first parameter is the silence threshold. What this number means is that 
anything below that number is considered to be a silence.

The second parameter is the silence minimum length. So for any portion of 
audio that is considered silent (below the silence threshold), a track split will 
be placed if it is longer than the silence minimum length. This second pa-
rameter is necessary so the program doesn’t add track splits to brief musical 
pauses. 

The default values are usually fine for your LP recordings, but in case you 
find that the automatic plitting is not getting it right- adjusting these param-
eters should do the trick.

Troubleshooting Tip- 

If you are getting too many track splits in your audio file, it means your 
silence threshold is too high, so more audio is considered islent when it 
shouldn’t be. Try lowering the silence threshold.

If you are getting too few track splits, your silence threshold is too low, so 
not enough silences are being recognized.

Adjust these settings, click okay, and re-analyze your file.

3.3 AutoSplitting: Analyze Tracks by Silence

To automatically separate your tracks, just click on the Settings menu and se-
lect “Analyze Tracks by Silence”.  Audio Workshop will do the rest, applying 
the parameters discussed above in 3.2 to identify the silence between songs. 

In the next section we will discuss how to adjust the track splits and how to 
place them manually.
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3.4 Basic Terms and Concepts

Before we get to working with track splits, let’s review some of the terminolo-
gy and concepts that pertain to our method of track splitting.

What is a track marker?
Take a look at the waveform to the right. You’ll notice two red lines placed 
over a visible silence in the audio track (visible because there is zero ampli-
tude- the wave is flat). We call these red lines “track markers”, or just plain 
“markers” for short.

If you need to move the marker around, simply drag it (place your cursor 
over the marker until it changes to the quadruple sided arrow). The wave-
form will always recalibrate itself after you move a marker.

What is the marker list?
The marker list may be the most pronounced improvement to our track 
splitting software. It is a list of all the track markers currently placed on the 
waveform. Double click on one of the markers to begin playback from that 
marker. It’s an easy way to make sure the markers are placed exactly where 
you need them to be.

What constitutes a track?
For a segment of the waveform to be considered a track, it needs to sit be-
tween two track markers. One track marker isn’t enough. Notice how the 
marker list begins with #0. That’s because the first track marker goes before 
the first track begins. The final track marker must be placed after the final 
track. When splitting automatically, you may not always see the last track 
marker, even though it will be represented in the marker list.

So the audio between track marker #0 and #1 is the first track from your file, 
between #1 and #2 is the second, and so on...

3.4a Manually Add a Track Marker

Check out the above waveform. Notice how the first track marker is at 4:01. That means all 
the audio before that will be ignored when I am saving my tracks. If I have a reason to delib-
erately ignore that audio, then that’s great. However, let’s say I do want that segment of audio.

I click on the waveform at the location where I wish to begin “track 1”. You can see the yellow 
dotted line indicating the position that was clicked (also note the bottom right hand corner 
where it says “Position” for a precise reading of the position). I click on the + button right 
beneath the markers list to add the track marker at my selected position. 

(Continued on next page with a screenshot)

Contents



Contents

After clicking the + button, a new track marker is placed where the yellow dotted line had 
been. You’ll see that the new marker is #0 and the rest got bumped up by a number.

You can also see that the track markers are reflected in the mini waveform that’s beneath the 
main one.

3.4b Delete a Track Marker

To delete a track marker, all you need to do is select a marker from the marker 
list, then click on the - button (the subtract symbol). 

Clicking on the X button clears all markers, so don’t do that unless you want 
to start over!

If you aren’t sure about which number marker it is that needs to be erased, 
instead of trying to count each one on the waveform, just double click the 
marker from the marker list. It will begin playing back from that location, 
and you can be certain if that was the one that needed to be deleted.

3.5 Exporting Your Tracks

Once you’ve completed placing all the appropriate track markers (whether 
automatically or manually), you are ready to export your tracks into individu-
al song files.

Under the File menu, click ‘Save Tracks As’.

You can select the output format which is just what kind of files do you want 
your tracks to be?
Your options are: WAV, MP3, FLAC, OGG and WMA.

You can choose the quality level of your files (higher quality means it will take 
up more disk space).

Select a target path (you should have a folder where you want to save this 
album).

If you use general track names, it will just title all of your tracks generically 
differentiating between them only by a number.

I always name my tracks according to song title. When you click on Use 
Custom Track Names, the program will tell you exactly how many tracks you 
need to name. To the right, you can see I need to create 6 track names. When 
I complete a track title, I hit ‘Enter’ on my keyboard to write the title of the 
next track. Each line number corresponds to that number track’s title.

If your saving as anything besides WAV, you also have optional ID tagging to 
fill out. See the next section.
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3.5a Tagging MP3, WMA, FLAC, OGG Files

The fun thing about tagging your song files is that most music players- 
whether programs on your computer or your smartphone- will organize 
songs based on Artist, Album or Song (according to your preferences). 

In addition, album art is usually displayed either on the side or in the 
background of the playing track. This is purely for your aesthetic enjoy-
ment. Nothing wrong with that, so no reason not to add this info if you 
can help it!

These fields are mostly self explanatory, so I will only discuss the follow-
ing:

The ‘Track’ checkbox. This tells Audio Workshop that you also wish to add 
track numbers to your song files. An underappreciated benefit to having 
track numbers is that in Windows 7 and 8, your files are automatically 
sorted. Usually alphabetically. You cannot customize that arrangement. 
You can, however, choose how your files are sorted. You can opt to sort 
them by track number. This is great because you can preserve the album 
order of the songs quickly and easily.

Of course, Audio Workshop doesn’t actually know which track numbers 
you are saving. And it doesn’t automatically assume you are saving from 
track 1.

Chances are, if you’re using our system to convert LP to MP3, you are 
digitizing one side at a time. So if you are now exporting the tracks for side 
B of the LP, you aren’t beginning with track 1. 

In Mitch Ryder’s “Breakout!” album, side B has six tracks. 
The first track on side B is “Devil With A Blue Dress On / Good Golly 
Miss Molly”. But it isn’t track 1 of the album. It’s actually track 7. 

So I input Track # Start: 7. 

Audio Workshop will then assign track numbers to each of the six songs 
I’m saving, but it starts  counting up from track 7. My six songs being 
saved will be tagged in ascending order with track numbers 7, 8, 9, 10, 11, 
12.

The next thing to discuss is how to add album art.

I find the easiest way to be going to Google.
Type in the album and artist name into the search bar.
Click on ‘Images’.
Find the thumbnail of the cover art you need.
Right click on it.
Save Image As... (rename it to whatever you want and save where you can 
easily find it).
From Audio Workshop- browse for it when you are tagging you songs by 
clicking on ‘Add’.

When you’ve tagged everything to your satisfaction, click on ‘Encode and 
Save Tracks’.

Audio Workshop will take some time to export and tag each individual 
track. 

You’ve successfully converted your analog audio into a digital file, and 
it’s ready to be played from your computer, transferred to your smart-
phone or MP3 player or burned to CD!
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